
தட்டச்சும் 
கணினி பயன்பாடுகளும்

செய்முறை

1 5 8
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பயிற்சி 
எண் பாடத் தலைப்பு பக்க எண் மாதம்

1 தட்டச்சு பயிற்சி 162-177 ஜூன்/ ஜூலை

2 சுருக்கம் மற்றும் சின்னங்கள் 178-179 ஜூலை/ஆகஸ்ட் 
செப்டம்பர்

3 பேஜ்மேக்கர் - ஆவணத்தை வடிவமைத்தல் 180-186 ஜூன்

4 பேஜ்மேக்கர் - அறிவிப்புப் பலகையை 
உருவாக்குதல் 187-189 ஜூன்/ ஜூலை

5 பேஜ்மேக்கர் - விசிட்டிங் கார்டை 
உருவாக்குதல் 190-196 ஜூலை/ ஆகஸ்ட்

6 பேஜ்மேக்கர் - ஒரு லேபிளை (Label) 
உருவாக்குதல் 197-199 ஆகஸ்ட்/செப்டம்பர்

7 MYSQL: தரவுத்தளத்தில் உள்ள 
கட்டளைகளின் பயன்பாடு 200-202 செப்டம்பர்

8 PHP – அடிப்படை நிரல் 203-204 செப்டம்பர்

அலுவலக மேலாண்மையும் செயலியலும் மற்றும் 
தட்டச்சும் கணினி பயன்பாடுகளும் 

செய்முறை
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	 தட்டச்சு என்பது ஒரு கலையாகும்.  
அது எழுத்தாற்றலின் செயல்முறையாக 
கருதலாம் (அ) உரைநடையை எழுதும் 
ப�ோது தட்டச்சு மூலமாக விசைக்கருவிகளை 
அழுத்தி (விசைபலகை) (அ) தற்போது 
உள்ள கைப்பேசியைக் க�ொண்டோ (அ) 
நவீன கணக்குப் ப�ொறியினை க�ொண்டு 
செயல்படுவதாகும்.  இது மற்ற உரை 
உள்ளீட்டு முறையிலிருந்து மாறு பட்டதாகும்.  
அதாவது எழுதுநடை மற்றும் பேச்சாற்றல் 
முறையிலிருந்து முற்றிலும் மாறுபட்டதாகும்.  
தட்டச்சின் மூலமாக, எழுத்துக்களையும், 
எண்களையும் மற்றும் பல்வேறு 
சின்னங்களையும் நாம் வெளிப்படுத்தலாம்.  
உலகின் முதல் தட்டச்சாளர் லில்லியன் 
ஷ�ோல்ஸ் ஆவார், அவர் விஸ்கான்ஸின் 
மாகாணத்தை சேர்ந்தவர் மற்றும் அவர் 
கிறிஷ்டோபர் ஷ�ோல்ஸ்.ன் மகளும் ஆவார்.  
அவர் தான் முதன் முதலில் தட்டச்சு ப�ொறியை 
உலகிற்கு அறிமுகப்படுத்தியவர் ஆவார்.

இந்த நடைமுறை தட்டச்சு பகுதியில் 
நாம் எவ்வாறு படிப்படியாக தட்டச்சு முறையை 
பயில்வது என்பதை பார்ப்போம்.  இதன்மூலம், 

மாணவர்களே!  தங்கள் வரவு நல்வரவு ஆகுக!

நல்ல பயிற்சியைப் பெற்று ஒரு சில மணி 
நேரங்களில், வேகமாகவும், துல்லியமாகவும் 
தவறின்றி தட்டச்சு ப�ொறியின் விசைகளை 
பார்க்காமல் தட்டச்சு செய்வது என்பதை 
தெளிவாக கற்கலாம்.  நம் இரு கரங்களில் 
உள்ள பத்து விரல்களை, எவ்வாறு 
விசைகளில் சரியாக இயக்க வேண்டும் 
என்பதே முக்கியம் எப்போதும் உங்கள் 
விரல்களை ‘நடுவரிசையில் உள்ள வீட்டு 
விசைகள்’ என்று கூறக் கூடிய பகுதியிலேயே 
இருக்க வேண்டும்.  முதலில் இடது கையின் 
சுண்டு விரலை A ய்யினையும், ம�ோதிர 
விரலை ‘S’ யையும், நடுவிரலை  ‘D’ மீதும், 
ஆட்காட்டி விரலை F மீதும், இடது கையின் 
கட்டை விரலை இடைவெளி சட்டத்தின் மீது 
வைக்க வேண்டும். வலது கையை ப�ொறுத்த 
மட்டும், ஆட்காட்டி விரலை ஜே(J) மீதும், 
நடுவிரலை  K மீதும், ம�ோதிர விரலை  ‘L’ மீதும் 
மற்றும் சுண்டு விரலை அடுத்த விசையின் 
மீதும் வைக்க வேண்டும்.  எப்பொழுதும் 
எந்த விசையை அழுத்தினாலும், மீண்டும் 
விரல்களை பழையபடி ‘வீட்டு விசைகள்’  மீது 
கையை க�ொண்டு வர வேண்டும்.  
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இங்கே கீழே க�ொடுக்கப்பட்ட படத்தில் 
இரு கைகளில் உள்ள விரல்களின் சரியான 
பயன்பாடு குறித்து விளக்கப்பட்டுள்ளது.

முக்கியமான விசைகருவிகளின் 
அமைப்பினைப் பற்றி கீழ்வரும் பாடங்களின் 
வாயிலாக எளிதாக கற்க வழிவகை 
செய்யப்பட்டுள்ளது.  முக்கியமாக நாம் தட்டச்சு 
பயிலும்போது விசைப்பலகையை பார்த்து 
தட்டச்சு செய்யக் கூடாது.  நாம் எதைப் பற்றி 
தட்டச்சு செய்கிற�ோம�ோ அந்த செய்தியை (அ) 
விவரத்தை பார்த்துக் க�ொண்டு விசையை 
இயக்குவது சரியான முறை ஆகும்.  முதல் 
பாடத்தை ஆரம்பிக்கும் ப�ோது ஆரம்பி என்ற 
‘விசைப�ொத்தானை’ அழுத்த வேண்டும்.
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தட்டச்சு பயிற்சி01

  மாதிரி விசைப்பலகை
	 கீழே க�ொடுக்கப்பட்டுள்ள படத்தில் வித்தியாசமான கலர்களில் விரல்களை 
காண்பிக்கப்பட்டுள்ளது.  ஒவ்வொரு விரல்களில் உள்ள கலர்களை விசைப்பலகைய�ோடு, 
அதில் க�ொடுக்கப்பட்டுள்ள கலர்களுடன் ஒப்பிட்டு இயக்க வேண்டும்.  அதை விளக்கும் 
விதத்தில் படம் இடம் பெற்றுள்ளது. 

படம் 1  மாதிரி விசை பலகை

பயி
ற்சி
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படம் 2  மாதிரி விசைபலகை, வலது மற்றும் இடது கை குறியிட்டுள்ளது.

இரு கைகளில் வித்தியாசமாக கலர்களில் விசையை எழுதப்பட்டுள்ளது.  

படம் 3  அந்தந்த கையின் விரல்களில் எழுத்துக்களை வடித்துள்ளது.
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  தட்டச்சு பயிற்சி – பாகம் I
அ) சிறு வாக்கியங்களை அமைத்தல், ஒவ்வொன்றும் 5 முறை பயிற்சி செய்யவும்:
	 1.	 Whatever you are, be a good one.

	 2.	 Be the change you wish to see in the world.

	 3.	 Try and fail, but never fail to try.

	 4.	 Choose death rather than dishonor.

	 5.	 Believe you can and you’re halfway through.

	 6.	 A false friend is worse than a bitter enemy.

	 7.	 To travel is to take a journey into yourself.

	 8.	 I haven’t been everywhere, but it’s on my favorite list.

	 9.	 Brief words are best on burning matters.

	 10.	 June  has put a spirit of youth in everything.

	 11.	 Lie down and listen to the crabgrass grow.

	 12.	 The earth laughs in flowers.

	 13.	 Water is the most precious force of all nature.

	 14.	 Human beings, must go back to nature for information.

	 15.	 Music should strike fire from the heart of human.

அஅ) வேக பயிற்சி செய்யவும்:
	 1.	 Hear twice before you speak once.

	 2.	 True friendship is a plant of slow growth.

	 3.	 I never think of the future it comes soon enough.

	 4.	 Hasty resolution seldom speeds well.

	 5.	 A poem begins in delight and ends in wisdom.

	 6.	 Fear of God is the beginning of wisdom.

	 7.	 Long ago I bought a dry gold necklace.

	 8.	 Krishna got 2/5 and Varsha 3/5 of their shares. 

	 9.	 Received 5 sets Table(2’6”) & Chairs (1’6”).

	 10.	 Pack my box with five dozen juice mugs.
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ஆ) கீழே க�ொடுக்கப்பட்டுள்ள சிறு பத்திகளை ஐந்து முறை பயிற்சி செய்யவும்:
   (ஆஆ) (சிறு) பத்திகளை ஐந்து முறை ஒவ்வொன்றும்
	 1.	 �Tracy looked at the flag. The flag is red, white, and blue. It has fifty white stars, seven 

red stripes, and six white stripes.

	 2.	 �Donald plays the piano. He loves the piano. He has a big piano in his living room. 
His piano is shiny and black. It has three legs and a bench.

	 3.	 �This weekend I went to the zoo. It was great. I went with my mom and dad. My sister 
came, too. The zoo was in the city. The zoo was very long.

	 4.	 �When I was playing today at recess, I felt like a kite blown around by the wind. It 
was hard to stay in one place because the wind was so strong.

	 5.	 �My teacher is awesome. I think she deserves an award for teaching. I have liked all 
my teachers, but she is by far the best I’ve ever had.

   (இஇ) (வழக்கமான) பத்தியை ஐந்து முறை தட்டச்சு செய்து பழகவும்: (ஒவ்வொன்றையும்)
	 1.	 India is a DEMOCRATIC SOCIALIST country in the World. Infect, DEMOCRATIC 

SOCIALISM has been offered as a solution to the DEVELOPMENTAL 
resolution which India has undertakes to break through the barrier of UNDER-
DEVELOPMENT of carrying forward the liberation of many millions of people 
and pushing through the DEVELOPMENT in all spheres of life. The SOCIALIST 
transformation which India aspires is that of building an independent, economy 
and comprehensive, including agriculture, on a modern technical basis as early 
as possible.

		      “India is my Country. All INDIANS are my Brothers & Sisters. I love my  
country and I am proud of its rich and varied heritage. I shall always strive 
to be worth of it. 

		      I shall give respect my parents, teachers and all elders and treat everyone  
with courtesy. To my Country and My People, I pledge my Devotion. In their 
well-being and prosperity alone lies my happiness”.

	 2.	 The question here is, are all of them entrepreneurs? The answer is both yes and 
no. If we say that an entrepreneur is a person, then all the above individuals are 
entrepreneurs. When we add that a person having his own business only is an 
entrepreneur, excepting Kamath and Prabhudeva, all the others are persons having 
their own business – small, very small, or large. But we say that an entrepreneur is a 
person who starts his own business. Chandrasekaran and Narayanan are taking care 
of the business started by their father; so they are not entrepreneurs. Ramu, whose 
mother prepares sundal and asks him to go to beach, sell and bring the money and 
give it to her, is also not an entrepreneur, but only an employee. Also, if shops and 
businesses are not started by them, then they also cannot be called entrepreneurs.
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தனிக்கையாளரின் சான்றிதழ் மாதிரியை தட்டச்சு செய்வது
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ச�ொத்துகள் மற்றும் ப�ொறுப்புகளை பற்றி விவரிக்கும் “இருப்பு நிலை 
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கமல் அவர்களின் இருப்பு நிலை குறிப்பு 
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வரவு செலவுக் கணக்கிணை தயார் செய்க: 
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இலாப நட்ட கணக்கிணை வரைக:
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பணம் பெறுதல் மற்றும் செலுத்துதல் கணக்குகல்
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விளம்பரம் – அழைப்பிதழ்
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அழைப்பிதழ் – மாதிரி 
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  தட்டச்சு பயிற்சி – பாகம் II
1. �வேகப்பயிற்சி – கீழ் வரும் கட்டூரையை பதினைந்து நிமிடத்தில் தட்டச்சு செய்து 

முடிக்கவும்.
அ) �The present constitution of India was framed by the Constitution Assembly of India set 

up under the Cabinet Mission Plan of May16, 1946. The idea of establishing a Constituent 
Assembly to draw up the Indian Constitution was not a new one. The American Constitution 
was framed by a Constitution Assembly. In fact, American Constitution has proved to be 
a model to the democratic world. Till independence, India was governed under the Acts 
passed by the British Parliament. In 1938 Sri Jawaharlal Lal Nehru declared: “The Indian 
National Congress stands for independence and a democratic state. It has proposed that 
the constitution of free India must be framed, without outside interference, by a constituent 
assembly elected on the basis of adult franchise. That is the democratic way and there is no 
other way short of revolution, which can bring the needed result. An assembly so elected will 
represent the people as a whole and will be far more interested in the economic and social 
problems of the masses than in the petty communal issues which affect small groups . ”

		  The inaugural meeting of the Constituent Assembly of India was held on December 
9,1946. It was presided over by Dr.Sachchidananda Sinha who was the oldest member of 
the Assembly. On December 11, 1946, Dr. Rajendra Prasad was elected President of the 
Constituent Assembly.

		  On December 13, 1946, Shri Jawahar Lal Nehru moved the “objectives resolution” which 
later became the Preamble of the Constitution.

		  A number of committees submitted reports to the Constituent Assembly on the different 
aspects of the constitution. On the basis of these reports the constitution was prepared by 
Constitutional Adviser, Sri B. N. Rao. The Drafting Committee under the chairmanship of 
Dr.Ambedkar worked on the draft  and produced the Draft Constitution with 315 articles 
and 8 schedules. The Draft Constitution was considered by the Constituent Assembly. In 
its progress through the Constituent Assembly, the constitution grew in bulk and took its 
final shape with 395 articles and 8 schedules. The time taken in accomplishing this task 
was exactly two years, eleven months and 17 days from the first meeting of Constituent 
Assembly on 9th December, 1946 till November 26, 1949 when “We, the people of India” 
gave unto ourselves the new constitution.

		  There have been over 92 amendments to our Constitution so far.

Procedure of Amendment:
The Indian Constitution is a combination of rigidity and flexibility. It has neither the rigidity 
of the American Constitution nor the flexibility of the British Constitution. Three different 
methods of amendment have been provided under the Indian Constitution.
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First, certain provisions of the constitution can be amended by Parliament by ordinary 
legislation. For example, Parliament may, by ordinary law (i.e., a law passed by a simple majority) 
form a new State out of the existing States, increase or decrease the area of any state, alter 
the name of any State, etc. Again, for abolition or creation of Legislative Councils in States, 
Parliament may, by ordinary law, provide for this, provided the Legislative Assembly of the State 
concerned passes a resolution to that effect by a majority of the total membership and at least 
a two-thirds majority of the members present and voting before Parliament undertakes to pass 
such a law.

Secondly, certain specified provisions can be amended by a special procedure. 

ஆ) � In case of the aforesaid order having been made any of the following persons shall be 
required to preserve and produce all the books, registers, other documents and records of 
and relating to the company/intermediary/other person being in its custody or power: (i) 
every manager, managing director, officer and other employee of the company ; (ii) every 
intermediary referred to in Section 12; (iii) every person associated with the securities 
market. The investigating Authority may also examine any of the aforesaid persons on 
oath. Further, Investigating Authority may also examine any of the aforesaid persons on 
oath.

		      Further, investigating Authority may call for information, books, registers or other 
documents and records which it considers relevant and necessary for the purpose of its 
investigation. It may keep the records produced before it in its custody upto 6 months. It 
may issue certified copies of those documents for use of the person on whose behalf the 
books and documents have been kept. In case any person referred to above refuses to or 
fails to furnish the desired books/records/information or refuses or fails to appear or sign 
the notes of any examination, he shall be punishable with imprisonment for a term which 
may extend to one year, or with fine, which may extend to one crore rupees, or with both, 
and also with a further fine which may extend to five lakh rupees for every day after the 
first during which the failure or refusal continues.

		      Investigating Authority has also been empowered to secure an order for seizure of 
books, registers, other documents and record by making an application to the Judicial 
Magistrate. Such an application can be made where in the course of investigation, the 
investigating Authority has reasonable ground to believe that the books, registers, other 
documents and records of, or relating to, any intermediary or any person associated with 
securities market in any manner, may be destroyed, mutilated, altered, falsified or secreted.

		      After considering the application and hearing the Investigating Authority, if necessary, 
the Magistrate may, by order, authorize the Investigating Authority- (a) to enter, with 
such assistance, as may be required, the place or places where such books, registers, other 
documents and record are kept; (b) to search that place or those places in the manner 
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specified in the order; and (c) to seize books, registers, other documents and record it 
considers necessary for the purpose of the investigation. 

	     However, in case of a company intended to get its securities listed on any recognized 
stock exchange, order shall be passed only if such company indulges in insider trading or market 
manipulation. Further, records seized must be returned back to the company/body corporate 
after the conclusion of the investigation. Search and seizure, as aforesaid, shall be carried out in 
accordance with the provisions of the Cr.P.C. 1973 relating to searches or seizures made under 
the Code.
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நிலையான சுருக்க பட்டியலை அறிந்து க�ொள்ள

சின்னம் ப�ொருள்

w/ with (something)

w/o without

w/i within

i.e. that is

e.g. for example

etc et cetera, so forth

bc because

b4 before

re: regarding, about

esp especially

min minimum

max maximum

govt government

ASAP as soon as possible

wrt write

rt right

yr / yrs year, years

சுருக்கம் மற்றும் 
சின்னங்கள்02பயி

ற்சி
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சின்னம் ப�ொருள்

c. circa, about, around, from the year

vs versus, as opposed to

ch chapter

Q   A question   answer

ex example

wd   wds word   words

ref reference

diff difference

முடிவடையும் வார்த்தையில் சுருக்கம் 
அறிதல்: 
�	govt - government
�	gov’t - government
�	interl – international
�	inter’l – international

ing யை புறகணித்தல்: 
�	ckg - checking
�	ckng - checking
�	ck’g - checking

ஆரம்பிக்கும் (அ) துவங்கும் முன் உள்ளா 
வார்த்தையின் சுருக்கம்: 
�	pol - politics
�	gov - government
�	subj - subject
�	info - information
�	intro – introduction

உயிரெழுத்தை புறகணித்தல்: 
�	prblm - problem
�	schl - school
�	bkgd – background
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வினா:
	(a)	 பேஜ்மேக்கரைத் திறந்து கீழ்க்கண்ட அளவுகளுடன் கூடிய ஒரு புதிய ஆவணத்தை 

உருவாக்கவும்.
		  பக்க அளவு - A4
		  பக்கங்களின் எண்ணிக்கை - 4
		  மேல் பக்க ஓரம் 1.25 அங்குலம் மற்ற பக்கங்கள் 0.75 அங்குலம்

	(b)	 கீழ்க்கண்ட உரையை உள்ளிடவும்.
		  HAPPINESS:
		  Happiness is often confused with fun, good living, and riches. Sometimes fun is equated 

with happiness. Fun is what we experience while doing an activity, whereas happiness is 
a residual and long-lasting feeling. The path to happiness is long and full of challenges. 
Happiness requires life-long pursuit.

	(c)	 HAPPINESS என்னும் தலைப்பிற்கு எழுத்து வகையின் அளவு 18 புள்ளிகள், எழுத்து 
வகை Arial, தடிமன், மைய இசைவு ஆகிய வடிவூட்டல்களைச் செய்க.

	(d)	 பத்திக்கு கீழ்க்கண்ட வடிவூட்டல்களைச் செய்க.
		  (a) Font			  - 	 Arial
		  (b) Font size	 -	 12
		  (c) Alignment 	 – 	 Justified
		  (d) Leading 	 –	 20			 

	(e)	 ஆவணத்தை ‘happiness’  என்ற பெயரில் சேமிக்க.	  

பேஜ்மேக்கர் -  
ஆவணத்தை வடிவமைத்தல்03பயி

ற்சி
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செய்முறை:
	 1.	 Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 என்ற 

வரிசையில் கிளிக் செய்து ஒரு புதிய பேஜ்மேக்கர் ஆவணத்தைத் திறக்கவும். படத்தில் 
காட்டியுள்ளவாறு அட�ோப் பேஜ்மேக்கர் சன்னல் திரை த�ோன்றும்.

 ந�ோக்கம்:
பேஜ்மேக்கரைத் திறந்து க�ொடுக்கப்பட்ட அளவுகளுடன் கூடிய ஒரு புதிய ஆவணத்தை 
உருவாக்குதல்
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	 2.	 பட்டிப்பட்டையில் File > New என்பதைக் கிளிக் செய்யவும். (அல்லது) Ctrl + N என்னும் 
விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இது Document Setup உரையாடல் 
பெட்டியைத் திறக்கும்.

�	Page Size கீழிறங்கு பட்டிப்பெட்டியில் கிளிக் செய்து A4 என்னும் பக்க அளவைத் 
தேர்ந்தெடுக்கவும்.

�	Number of pages  உரைப்பெட்டியில் 4 என உள்ளிடவும்.
�	ஓரங்களின் அளவை கீழ்க்கண்டவாறு மாற்றவும்.
	 Inside 	 –	 0.75 inches
	 Outside 	 –	 0.75 inches
	 Top	 –	 1.25 inches
	 Bottom	 –	 0.75 inches
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	 3.	 OK  ப�ொத்தானை கிளிக் செய்யவும். படத்தில் காட்டியுள்ளவாறு Untitled – 1 என்ற பெயரில் 
புதிய ஆவணம் திரையில் த�ோன்றும்.

	 4.	 டெக்ஸ்ட் டூலைக் கிளிக் செய்து ஒரு உரைத்தொகுதியை உருவாக்கவும். பிறகு கீழே 
க�ொடுக்கப்பட்டுள்ள உரையை தட்டச்சு செய்யவும்.

		  HAPPINESS:
		  Happiness is often confused with fun, good living, and riches. Sometimes fun is equated 

with happiness. Fun is what we experience while doing an activity, whereas happiness is 
a residual and long-lasting feeling. The path to happiness is long and full of challenges. 
Happiness requires life-long pursuit.
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	 5.	 டெக்ஸ்ட் டூலைக் க�ொண்டு ‘HAPPINESS’ என்பதைத் தேர்ந்தெடுக்கவும். Character Control 
Palette மூலம் எழுத்து வகை Arial, எழுத்து வகையின் அளவு 18 புள்ளிகள், Leading  22 
என மாற்றவும். Bold ப�ொத்தானைக் கிளிக் செய்யவும். பிறகு மைய இசைவிற்கு Shift + 
Ctrl + C என்னும் சாவி சேர்மானத்தை அழுத்தவும். 
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	 6.	 டெக்ஸ்ட் டூலைக் க�ொண்டு பத்தியைத் தேர்ந்தெடுக்கவும். Character Control Palette 
மூலம் எழுத்து வகை Arial, எழுத்து வகையின் அளவு 12 புள்ளிகள், Leading 20 என 
மாற்றவும். பிறகு நேர்த்தி இசைவிற்கு Shift + Ctrl + J என்னும் சாவி சேர்மானத்தை 
அழுத்தவும்.
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	 7.	 ஆவணத்தை ‘happiness’ என்ற பெயரில் சேமிக்க
		  விசைப்பலகையில் Ctrl + S என்பதை அழுத்தவும் அல்லது பட்டிப்பட்டையில் File > Save 

என்பதைக் கிளிக் செய்யவும். Save publication உரையாடல் பெட்டி த�ோன்றும். File name 
உரைப்பெட்டியில் ‘happiness’ என தட்டச்சு செய்து Save ப�ொத்தானைக் கிளிக் செய்யவும்.

வெளியீடு:

HAPPINESS
Happiness is often confused with fun, good living, and riches. Sometimes fun is 

equated with happiness. Fun is what we experience while doing an activity, whereas 

happiness is a residual and long-lasting feeling. The path to happiness is long and 

full of challenges. Happiness requires life-long pursuit.

முடிவு:
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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வினா:
பேஜ்மேக்கரைப் பயன்படுத்தி கீழ்க்கண்ட மாணவர் அறிவிப்புப் பலகையை உருவாக்கு.

 ந�ோக்கம்:
பேஜ்மேக்கரைப் பயன்படுத்தி மாணவர் அறிவிப்புப் பலகையை உருவாக்குதல்.

செய்முறை:
	 1.	 Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   

என்ற வரிசையில் கிளிக் செய்து ஒரு புதிய பேஜ்மேக்கர் ஆவணத்தைத் திறக்கவும். 
	 2.	 பட்டிப்பட்டையில் File > New என்பதைக் கிளிக் செய்யவும். (அல்லது) Ctrl + N என்னும் 

விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இது Document Setup உரையாடல் 
பெட்டியைத் திறக்கும்.

	 3.	 OK ப�ொத்தானை கிளிக் செய்யவும். இப்பொழுது Untitled – 1 என்ற பெயரில் புதிய 
ஆவணம் திரையில் த�ோன்றும்.

	 4.	 ரெக்டாங்கல் டூலைப் பயன்படுத்தி 100 mm x 100 mm அளவுள்ள பெட்டியை வரைய 
வேண்டும். அதில் சியான் (Cyan) நிறத்தை நிரப்பவும். tint மதிப்பை 25 சதவீதமாக 
மாற்றவும். இப்பொழுது பெட்டி கீழ்க்கண்டவாறு த�ோன்றும்.

பேஜ்மேக்கர் - அறிவிப்புப் 
பலகையை உருவாக்குதல் 04 பயி

ற்சி
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	 5.	 இதேப�ோன்று 100 mm x 15 mm அளவுள்ள மற்றொரு பெட்டியை வரைய வேண்டும். 
அதில் கருப்பு (black) நிறத்தை நிரப்பவும். இந்தப் பெட்டியை சியான் (Cyan) நிறம் 
நிரப்பப்பட்ட பெட்டியின் மேல்பகுதியில் வைக்கவும். இப்பொழுது பெட்டி கீழ்க்கண்டவாறு 
த�ோன்றும்.
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	 6.	 டெக்ஸ்ட் டூலைக் கருப்பு நிறப் பெட்டியின் இடது ஓரத்திலிருந்து வலது ஓரம் வரை கிளிக் 
செய்து இழுக்க வேண்டும். பின்னர் அதில் “ Student Notice Board” என்று தட்டச்சு செய்ய 
வேண்டும்.

		  எழுத்தின் நிறமும் பெட்டியின் நிறமும் ஒன்றாக (கருப்பாக) இருக்கும். உரையை தட்டச்சு 
செய்து முடித்தவுடன் Ctrl + A  என்னும்  விசைப்பலகை குறுக்கு வழி மூலம் உரையை 
தேர்ந்தெடுக்கவும்.

		  Character Control palette மூலம் எழுத்தின் அளவை 20 புள்ளிகளாக மாற்றவும். Bold 
பணிக்குறியைக் கிளிக் செய்யவும். Reverse ப�ொத்தானைக் கிளிக் செய்தால் உரை 
வெள்ளை நிறமாக மாறும். உரையை மைய இசைவு செய்ய Shift + Ctrl + C என்னும் 
விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இப்பொழுது மாணவர் அறிவிப்புப் 
பலகை கீழ்க்கண்டவாறு திரையில் த�ோன்றும்.

வெளியீடு:

முடிவு:
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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வினா:
பேஜ்மேக்கரைப் பயன்படுத்தி கீழ்க்கண்ட விசிட்டிங் கார்டை உருவாக்கு.

 ந�ோக்கம்:
பேஜ்மேக்கரைப் பயன்படுத்தி க�ொடுக்கப்பட்டுள்ள விசிட்டிங் கார்டை உருவாக்குதல்.

செய்முறை:
	 1.	 Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   என்ற 

வரிசையில் கிளிக் செய்து ஒரு புதிய பேஜ்மேக்கர் ஆவணத்தைத் திறக்கவும். படத்தில் 
காட்டியுள்ளவாறு அட�ோப் பேஜ்மேக்கர் சன்னல் திரை த�ோன்றும்.

பேஜ்மேக்கர் - விசிட்டிங்  
கார்டை உருவாக்குதல்05பயி

ற்சி
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	 2.	 பட்டிப்பட்டையில் File > New என்பதைக் கிளிக் செய்யவும். (அல்லது) Ctrl + N என்னும் 
விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இது Document Setup உரையாடல் 
பெட்டியைத் திறக்கும்.
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	 3.	 OK  ப�ொத்தானை கிளிக் செய்யவும். படத்தில் காட்டியுள்ளவாறு Untitled – 1 என்ற பெயரில் 
புதிய ஆவணம் திரையில் த�ோன்றும்.

	 4.	 இப்பொழுது அளவீடுகளை Inches லிருந்து Millimetersக்கு மாற்றவும். 
		  பட்டிப்பட்டையில் File > Preferences > general  என்ற கட்டளையைக் கிளிக் செய்யவும். 

(அல்லது) விசைப்பலகையில் Ctrl + K என்பதை அழுத்தவும். இப்பொழுது Preferences 
உரையாடல் பெட்டி த�ோன்றும்.

		  அதில் Measurements மற்றும் Vertical ruler கீழிறங்கு பட்டிப்பெட்டியில் Millimeters  
என்பதைத் தேர்ந்தெடுக்கவும்.
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	 5.	 கருவிப் பெட்டியிலிருந்து ரெக்டாங்கல் டூலைத் தேர்ந்தெடுத்து செவ்வகம் வரையவும்.
	 6.	 Control Palette இல் width  95 mm  எனவும் height  55 mm எனவும் மாற்றவும்.  
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	 7.	 கருவிப்பெட்டியில் டெக்ஸ்ட் டூலை கிளிக் செய்யவும். தட்டச்சு செய்ய வேண்டிய உரையின் 
எல்லையைக் குறிப்பிட செவ்வகத்தின் இடது மூலையிலிருந்து வலது மூலை வரை 
கிளிக் செய்து இழுக்கவும்.

	 8.	 நபரின் பெயரை உள்ளிட்டு, அதை டெக்ஸ்ட் டூல் மூலம் தேர்ந்தெடுக்கவும். Control Palette 
மூலம் தேவையான எழுத்து வகை மற்றும் எழுத்தின் அளவைக் க�ொடுக்கவும். பின்னர் 
வலது புறமாக சிறிது நகர்த்தவும்.
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	 9.	 படிநிலை 7 ஐ மறுபடியும் செய்யவும். நிறுவனத்தின் பெயரை உள்ளிட்டு, அதை டெக்ஸ்ட் 
டூல் மூலம் தேர்ந்தெடுக்கவும். Control Palette மூலம் தேவையான எழுத்து வகை மற்றும் 
எழுத்தின் அளவைக் க�ொடுக்கவும். பின்னர் வலது புறமாக சிறிது நகர்த்தவும். முதல் 
எழுத்தை டெக்ஸ்ட் டூல் மூலம் தேர்ந்தெடுத்து எழுத்து வகையின் அளவை பெரிதாக்கவும்.
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	 10.	 படிநிலை 7 ஐ மறுபடியும் செய்யவும். நிறுவனத்தின் முகவரியை உள்ளிட்டு, அதை 
டெக்ஸ்ட் டூல் மூலம் தேர்ந்தெடுக்கவும். Control Palette மூலம் தேவையான எழுத்து வகை 
மற்றும் எழுத்தின் அளவைக் க�ொடுக்கவும். பின்னர் வலது புறமாக சிறிது நகர்த்தவும்.

வெளியீடு:

முடிவு:
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.

12th STD OMS_Tamil version Practicals.indd   196 1/14/2020   4:41:01 PM



1 9 7செய்முறை

வினா:
பேஜ்மேக்கரைப் பயன்படுத்தி கீழ்க்கண்ட லேபிளை (Label) உருவாக்கு.

 ந�ோக்கம்:
பேஜ்மேக்கரைப் பயன்படுத்தி க�ொடுக்கப்பட்டுள்ள லேபிளை (Label) உருவாக்குதல்.

செய்முறை:
	 1.	 Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   என்ற 

வரிசையில் கிளிக் செய்து ஒரு புதிய பேஜ்மேக்கர் ஆவணத்தைத் திறக்கவும்.  
	 2.	 பட்டிப்பட்டையில் File > New என்பதைக் கிளிக் செய்யவும். (அல்லது) Ctrl + N என்னும் 

விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இது Document Setup உரையாடல் 
பெட்டியைத் திறக்கும்.

	 3.	 OK  ப�ொத்தானை கிளிக் செய்யவும். இப்பொழுது Untitled – 1 என்ற பெயரில் புதிய 
ஆவணம் திரையில் த�ோன்றும்.

பேஜ்மேக்கர் - ஒரு லேபிளை 
(Label) உருவாக்குதல் 06 பயி

ற்சி
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	 4.	 பிறகு அளவீடுகளை Inches லிருந்து Millimeters க்கு மாற்ற வேண்டும். 
		  பட்டிப்பட்டையில் File > Preferences > general  என்ற கட்டளையைக் கிளிக் செய்யவும். 

(அல்லது) விசைப்பலகையில் Ctrl + K என்பதை அழுத்தவும். இப்பொழுது Preferences 
உரையாடல் பெட்டி த�ோன்றும்.

அதில் Measurements மற்றும் Vertical ruler கீழிறங்கு பட்டிப்பெட்டியில் Millimeters  என்பதைத் 
தேர்ந்தெடுக்கவும்.
	 5.	 கருவிப்பெட்டியிலிருந்து ரெக்டாங்கல் டூலைத் தேர்ந்தெடுத்து செவ்வகம் வரையவும்.
	 6.	 Control Palette இல் width  100 mm எனவும் height  40 mm எனவும் மாற்றவும்.  
	 7.	 பட்டிப்பட்டையில் Element > Rounded corners என்பதைக் கிளிக் செய்யவும்.
	 8.	 Rounded corners உரையாடல் பெட்டியிலிருந்து தேவையான வடிவத்தைத் 

தேர்ந்தெடுக்கவும். இப்பொழுது வட்டமுனை செவ்வகம் த�ோன்றும்.
	 9.	 கருவிப்பெட்டியில் டெக்ஸ்ட் டூலைக் கிளிக் செய்து, செவ்வகத்திற்குள் ஒரு 

உரைத்தொகுதியை உருவாக்கவும்.
	 10.	 Name : என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
		  STD :  என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
	 	 Section : என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
		  School : என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
		  Subject :  என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
	 11.	 டெக்ஸ்ட் டூலைக் க�ொண்டு உரை முழுவதையும் தேர்ந்தெடுக்கவும்.
	 12.	 பட்டிப்பட்டையில் Type > Indents / Tabs என்பதைக் கிளிக் செய்யவும். (அல்லது) 

விசைப்பலகையில் Ctrl + I என்பதை அழுத்தவும். 
	 13.	 வலது tab ஐ 90 mm அளவில் ப�ொருத்தவும்.  leader ப�ொத்தானைக் கிளிக் செய்து வரும் 

பட்டியலில் புள்ளிக்கோட்டைத் தேர்ந்தெடுக்கவும். பின்னர் Apply ப�ொத்தானைக் கிளிக் 
செய்யவும்.
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	 14.	 இப்பொழுது தேவையான லேபிள் உருவாக்கப்பட்டிருக்கும்.

வெளியீடு:

முடிவு:
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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செய்முறை:
	 1.	 (MYSQL command prompt யை திறக்க) XAMPP control panel வழியாக
	 2.	 தரவுத்தளத்தில் உங்களுடைய பயனர் பெயர் (user name) மற்றும் கடவுச்சொல்லைப் 

(password) பயன்படுத்தி உள்நுழைதல் 
	 3.	 க�ொடுக்கப்பட்ட  DDL MysQL வினாவலையினை செயல்படுத்தி வெளியீட்டைப் பெறுக.

SYNTAX: 
Based on the below syntax queries are built and executed.

* CREATE DATABASE testDB;

* CREATE TABLE table_name (column1datatype,column2datatype,column3datatype,   .... );

* ALTER TABLE `table_name` ADD COLUMN `column_name` `data_type`;

* DROP DATABASE databasename;

* SELECT * FROM TABLE NAME

* INSERT INTO table_name( field1, field2,...fieldN )   VALUES ( value1, value2,...valueN );

* UPDATE table_name SET field1 = new-value1, field2 = new-value2 [WHERE Clause]

* DROP TABLE table_name ;

	 1.	 CREATE	 -	 தரவுத்தளம் மற்றும் அதன் ப�ொருட்களை உருவாக்குதல்  (table, 
index, views, store procedure, function, and triggers)

	 2.	 ALTER	 -	 ஏற்கனவே இருக்கும் தரவுத்தளத்தை மாற்றியமைத்தல்.
	 3.	 DROP	 -	 தரவுத்தளத்தில் உள்ள ப�ொருளை நீக்குதல்.
	 4.	 SELECT	-	 தரவுத்தளத்தில் ஒரு தகவலை திரும்ப எடுத்தல்.
	 5.	 INSERT	-	 தரவை ஒரு அட்டவணையில் சேர்த்தல். 
	 6.	 UPDATE	 -	 அட்டவணையில் ஏற்கனவே உள்ள தரவை மேம்படுத்துதல்
	 7.	 DELETE	-	 தரவுத்தள அட்டவணையில் உள்ள அனைத்துத் தகவல்களையும் 

நீக்குதல்.

 ந�ோக்கம்:
My sql ஐப் பயன்படுத்தி DDL மற்றும் DML விணவலைச் செயலாக்கல் 

MYSQL: தரவுத்தளத்தில் உள்ள 
கட்டளைகளின் பயன்பாடு07பயி

ற்சி
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நிரல்:
CREATE DATABASE SchoolDB;

CREATE TABLE student(

studentID int,

LastName varchar(255),

FirstName varchar(255),

Address varchar(255),

City varchar(255) 

);

ALTER TABLE `members` ADD COLUMN `credit_card_number` VARCHAR(25);

DROP DATABASE SchoolDB

SELECT * FROM student

INSERT INTO student    (studentID ,LastName , FirstName,Address,City  )    VALUES

   (“002”, “Ram”,”Kumar”, “ROJA NAGAR”,”CHENNAI”);

SELECT * FROM student

UPDATE student SET LastName = ‘SRI’ WHERE studentID = 003;

SELECT * FROM student

DROP TABLE student ;

SELECT * FROM student

12th STD OMS_Tamil version Practicals.indd   201 1/14/2020   4:41:02 PM



2 0 2 செய்முறை

வெளியீடு:
Database created

Table created:

studentID LastName FirstName Address City

Table Altered

Database dropped

StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden 
St

Madurai

One row inserted.

StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden 
St

Madurai

002 Ram Kumar ROJA NAGAR CHENNAI

003 R Krishna Park Street Coimbatore

StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden 
St

Madurai

002 Ram Kumar ROJA NAGAR CHENNAI

003 SRI Krishna Park Street Coimbatore

Table dropped.

Table not found.
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செய்முறை: 
	 1.	 Xampp Server (Apache) துவங்குதல்.
	 2.	 Goto நிகர் க�ோப்புறைக்கு செல்லுதல் (Virtual path folder) (c:\xampp\ntdoc)
	 3.	 test.php file க�ோப்பினை உருவாக்கி, நிரலை தட்டச்ச செய்க.
	 4.	 (http://local host/test.php) என்ற பட்டலை பயன்படுத்தி உங்கள் வலை உலாவியில் (web 

browser)நிரலை இயக்கவும்.

நிரல்:
<html>

<body>

<?php

echo “Welcome to  Our School”;

$color = “blue”;

echo “My car is “ . $color . «<br>”;

echo “My dress is “ . $COLOR . «<br>”;

echo “My box is “ . $coLOR . «<br>”;

// test whether a number is greater than 30, 20 or 10 using ternary operator

functiontrinary_Test($n){

$r = $n > 30

? “greater than 30”

: ($n > 20

? “greater than 20”

: ($n >10

? “greater than 10”

 ந�ோக்கம்:
அடிப்படைPHP நிரலை உருவாக்கி வெளியீட்டை பெறுதல்.

PHP – அடிப்படை நிரல் 08 பயி
ற்சி
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: “Input a number atleast greater than 10!”)); 

echo $n.” : “.$r.”\n”;

}

trinary_Test(32);

trinary_Test(21);

trinary_Test(12);

trinary_Test(4);

 ?>

</body>

</html>

வெளியீடு:

Welcome to  Our School

My car is blue

My dress is

My box is

32 : greater than 30                                        

21 : greater than 20                                        

12 : greater than 10                                        

4 : Input a number atleast greater than 10!

12th STD OMS_Tamil version Practicals.indd   204 1/14/2020   4:41:02 PM


	12th STD OMS_Tamil version Practicals

